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 D.1. Tutorial 1: Soldier pile wall with struts 

 
We will be studying a composite wall of the soldier-pile type. The stability of the wall will be 
guaranteed by two layers of struts. 

 

 
 

3D view of retaining structure project 

 

 
Calculation cross-section 

  

ZTN = +14.0 NGF
1st level of struts:  z = +13.0 NGF

Z = +12.0 NGF

Z = +10.0 NGF
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Storage area (50 kPa)
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Excavation to +12.0 m

2nd level of struts:  z = +9.0 NGF

20.0 m

zw = +4.0 NGFzw = +4.0 NGF

Clays 1

Clays 2

Sands
Excavation to +8.0 m



D – Tutorial Manual K-Réa v4   

 

 
 

4/107 Copyright  K-Réa v4 – 2016 – June 2016 Edition  

The retaining structure is situated 4 metres from an existing storage area, which can be 
compared to a constant load of 50 kPa over a length of 10 metres. 
The modelling of the wall shall consider an initial phase to take account of this load that 
exists prior to the construction. 
 
The retaining structure consists of two circular concrete piles reinforced by a metal section 
inside each pile. We consider that the metal beams alone take up the wall internal loads. 
 
The characteristics of the piles are as follows: 

 Diameter = 0.62 m 

 Spacing = 2.20 m (axis-to-axis) 

 Metal section: HEB 360 

 

In the initial phase we will apply the active/passive earth pressure reduction coefficients to 
take account of the composite nature of the wall. 

The phasing then comprises 3 excavation phases with gradual installation of sheeting and 2 
levels of struts: HEB 320 spaced 4.40 m apart. 
 
The soil cross-section comprises three soil layers. The characteristics of the layers are given 
further on in the exercise. We will be carrying out a study without ULS checks using a MISS 
calculation without weighting factors. The ULS checks will be dealt with in other examples. 
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D.1.1. Step 1: Data input 

 
To start K-Réa: 
 

 Double-click the K-Réa icon. 

 Choose the appropriate protection mode, select the appropriate language and click 
OK.  

 Choose New project to access the Title and Options form. 

 

D.1.1.1. Title and options 

 

 
 

 In the Project type frame (right), select “Simple wall”. 

 In the Title/Project number frame, input the title and the project number of your 
choice. 

 In the Units frame, choose the units system for your project, by ticking “Metric, kN, 
kN/m2”. 

 Choose Definition of the project in ”Levels”, which enables the vertical axis to be 
directed upwards. 

 Additional checks: leave the “Perform the ULS checks” box unticked for this 
example. 

 In the Curves display frame, tick the “Same horizontal scale for curves” box. 

 Choose the Language for output. 

 In the Calculation options frame, keep the default settings: 100 iterations per 
calculation phase and calculation step of 0.2m for the wall. 

 In the Water options frame, leave the water weight setting of 10.00 kN/m³. 

 Click on the  button. 

 K-Réa then asks you to save the new project: define the appropriate name and 
directory. 
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D.1.1.2. Definition of soil layers 

The characteristics of the 3 layers of soil in the project must now be defined. 
 

 Fill out the characteristics of the first soil layer. By default, the first line of the 
summary table is selected. 

 Click the input box corresponding to Phreatic level and enter  
zw = +4 m. 

 Input the “Name” of the first soil layer: Clays 1. 

 Give the Level of top of layer z = +14 m. 

 Repeat this operation to input , d, , c, δa/φ, δp/φ and pmax the values of which are 
given in the following summary table: 

 
Layer 
name 

z 
(m) 

γ 
(kN/m

3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kN/m²) 

dc 
(kN/m²/m) 

δa/φ 
(-) 

δp/φ 
(-) 

pmax 

(kN/m/ml) 

Clays 1 14 20 10 15 5 0 +0.667 -0.667 700 

 

The values of δa/ and δp/ correspond to: 

 An inclination of +2/3  of the active earth pressure (downwards) 

 An inclination of -2/3  of the passive earth pressure (upwards) 

 
The value of dc corresponds to the increase in cohesion with depth. 
In this example, we consider that cohesion is constant over the height of the layer (dc = 0). 
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The following screenshot illustrates that of K-Réa following these operations: 
 

 
 
Tick the “Modify advanced parameters” box. 
 

To complete coefficients k0, ka, kp, kac, kpc, kd, kr, we will use the automatic wizards:  
 

 Click the:  button 

 
These various values are then filled out in accordance with the following principles: 

o k0 is calculated using the Jaky formula, with Roc = 1,  = 0 and taking account 
of the characteristics already input above. 

o ka is calculated via the "Kérisel and Absi tables" wizard – Active earth pressure, 

weighted cohesionless soil, without overload, with  = 0 and / = 0 (horizontal 
ground) and taking account of the characteristics already input above. 

o kp is calculated via the "Kérisel and Absi tables" wizard – Passive earth  

pressure, weighted cohesionless soil, without overload, with  = 0 and / = 0 
and taking account of the characteristics already input above. 

o kd = kr = k0. 

o kac and kpc (coefficients applied to the cohesion value) are obtained with the 
corresponding wizard. 
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o kag,min corresponds to the minimum active earth pressure coefficient required by 

the French Standard P 94-282. By default, the value is equal to 0.1 to take 
account of a horizontal active thrust stress of at least 10% of the effective 
vertical stress. This enables a minimum active earth pressure to be considered 
in the case of cohesive soils (our case). 

 
 

 
 

 
o pmax represents the maximum allowable soil pressure value. In this example, it 

plays an important role. Its value will be the bound of the allowable soil passive 
earth pressure limit in accordance with standard NF P 94-282 Appendix B.3.6. It 
corresponds to the creep pressure (pf) or the limit pressure (pl) depending on 
the type of calculation (SLS or ULS respectively). 
 

o In this example, leave value dc = 0. 
 

 One now needs to simply define the value of kh and its increment. To do this, enter 
the value of 14 000 kN/m²/ml for kh (this value was not determined here by a wizard 
but it is assumed that it is known in the context of this exercise). Then click the dkh 
box to input the value 0 (kh constant with depth). 

 In order to display the summary of the characteristics of this soil layer, click the 
summary table. 

Note: in this dialogue box, the fact of clicking  will validate your inputs, 

but if you quit this dialogue box in any other way, your inputs will be cancelled. 

 In the same way, input the other two soil layers by clicking the  button and 

referring to the following summary table: 

 

Layer 
z 

(m) 
γ 

(kN/m
3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kN/m²) 

dc 
(kN/m²/m) 

δa/φ 
(-) 

δp/φ 
(-) 

pmax 

(kN/m/ml) 

Clays 1 14 20 10 15 5 0 +0.667 -0.667 700 

Clays 2 12 20 10 15 10 0 +0.667 -0.667 800 

Sands 10 20 10 35 0 0 +0.667 -0.667 1 000 

 
Then use the K-Réa wizards to calculate the parameters used to constitute the behaviour law 
for each layer. 
  

c ≠ 0 (terrain cohésif)

( )

(cohesive soil) 
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The following parameters are to be obtained using the wizards.  
 

Layer 
k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 
kh 

(kN/m
²
/ml) 

dkh 

(kN/m³/ml) 
kd kr kaγ,min 

Clays 1 0.741 0.529 2.019 1.740 3.715 14 000 0 0.741 0.741 0.100 

Clays 2 0.741 0.529 2.019 1.740 3.715 15 000 0 0.741 0.741 0.100 

Sands 0.426 0.227 7.345 0 0 40 000 0 0.426 0.426 0.100 

 
The following screen is then obtained: 
 

 

 
 

Click . 

 
To edit or modify the soil layers subsequently, click Data Menu, then Soil layers. 
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D.1.1.3. Definition of the wall 

 

 Wall levels: 
 
The upper level of the wall is at elevation GL, that is z0 = +14.0 m. 
The lower level of the wall is at elevation zbase = +2.0 m.  
 

 Product of inertia of wall (EI): 
 
The product of inertia corresponds to that of the HEB 360 metal sections spaced every 
2.20 m, because we will consider that they alone take up the wall internal forces. 

The sections are spaced at intervals of 2.20 m (axis-to-axis). 
 

 
HEB 360 every 2.20 m 

Plan view of retaining structure from excavation side 
 

 
Plan view of a 620 mm pile reinforced with an HEB360 section 

 
  

HEB360 spaced 
every 2.20 m 
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Definition of wall with K-Réa: 
 

 Input the wall upper level z0 = +14.0 m. 

 Click the first line of the table (corresponding to the first wall section to be defined, 
which in this particular example will be the only one), in the first column input the base 
of the section, here elevation zbase = +2.0 m. 

 Then click the  button to determine the EI product of the steel sections:  

o Choose the Composite wall tab, then select “Steel sections”. 

o From the drop-down list of sections, choose HE 360 B. 

o Then input the horizontal spacing (axis-to-axis) of the sections at 2.20 m.  

o We will not take account of the inertia contributed by the sheeting between the 
steel sections and will thus leave the corresponding input zones empty. 

 Click  then quit the wizard. 

 

 
 

 

Finally, click  to take account of the values input and the data will appear on 

the graphic representation of the project initial data. To modify the characteristics of the 
wall subsequently, click the Data menu, then Wall Definition. 
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D.1.2. Step 2: Phasing definition 

The K-Réa main window now shows the project’s initial phase with a representation of the 
soil layers and wall. 
 
 

 
The actions to be considered in each construction phase should now be defined.  
 
These actions are summarised in the following table on the basis of the chosen phasing: 
 

PHASE ACTIONS 

Initial 
Before works 

 Boussinesq overload of 50 kN/m/ml at 4 metres behind the wall over a width 
of 10 metres. 

 Reduced active and passive earth pressure over entire height of wall. 

1 
Excavation 

 Intermediate excavation with installation of sheeting at +12.0 m. 

2 
1

st
 layer struts 

+ Excavation 

 Installation of layer of horizontal struts (HEB 320 every 4.40 m axis-to-axis 
distance) at +13.0 m, or Klayer struts = 76 984 kN/m/ml (work only authorised in 
compression, no preload) 

 Intermediate excavation with installation of sheeting down to +8.0 m. 

3 
2

nd
 layer struts 

+ Excavation 
to bottom of 
excavation 

 Installation of a strut layer at +9.0 m (same mechanical and geometrical 
properties as previous layer of struts). 

 Excavation to bottom of excavation with installation of sheeting down to 
+5.0 m. 
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D.1.2.1. Initial phase 

In the initial phase, the first action to be defined is a Boussinesq overload to take account 
of the existence of the storage area behind the wall, before it is built. 
 
We define a Boussinesq overload as follows: 
 

1. In the “List of available actions” frame, “Loads – Forces - Moments” category, the  

drop-down list can be used to select the “Boussinesq overload” action. Clicking the 
“Transfer” button  will call it up in the list of actions for the initial phase, in the 

right-hand part of the window. 

2. Set the overload to “Right”. 

3. Input the following values: 

o z = + 14.0 m 

o x = 4 m (behind the wall) 

o L = 10 m (overload application width) 

o q = 50 kN/m/ml 
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The Reduced active earth pressure action must then be defined, so that the reduced active 
and passive earth pressure stresses can be taken into account for the wall, owing to the fact 
that it is composite.  
 
This action will then be gradually “cancelled out” during the phasing, as installation of the 
sheeting progresses. The effect of the sheeting is to make the wall continuous, so the active 
and passive earth pressures will once again be taken into account in full over the height at 
which the wall is continuous.  

To define this action: 

 Select Reduced pressure from the drop-down menu of “Soil characteristics” actions 
in the initial phase. Click transfer button .  

 In the “Reduced pressure” definition frame, input the following information: 

o zt = +14.0 m o R = 0.845 

o zb = +2.0 m o C = 1 

 
This action is represented by a dotted black line on both sides of the wall. 

 

 
 
 
All the actions in the initial phase have now been defined. 
 

To create a new calculation phase and continue to input the phasing data, click  next to 

the initial phase tab (“P00”). A new tab appears for this new phase. As no action has yet 
been defined for this new phase, the list of actions is blank and its graphic representation is 
the same as that of the previous phase. 
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How to determine the reduced width for calculation of the limit active pressure and 
limit passive pressure according to standard NF P 94 282 for a composite wall? 

 

 Reduced width for calculation of limit active earth pressure (NF P 94 282 Appendix 
B): 

 
La = β x D = 3 x 0.62 m = 1.86 m 

 
Where: β = ultimate passive earth pressure ratio = 1 + 2 x D / D = 3 (rubbing and 

cohesive soil) 
 D = equivalent diameter of metal section taken as equal to pile diameter 

 

 Reduced width for calculation of limit passive earth pressure (French Standard 
P94 282 Appendix B): 

 
Lb = La = 1.86 m 

 

Calculation of R and C: 

In K-Réa, we will prescribe these calculation widths for the limit active and passive earth 
pressures by means of reduction coefficients R and C. They apply directly to the theoretical 
Pa and Pb pressure values calculated for a continuous wall. They will be applied over the 
height between zt and zb inclusive. 
 

 Reduction coefficient for limit active earth pressure: R = La / e = 1.86 m / 2.20 m = 
0.845 

 Reduction coefficient for limit passive earth pressure: R x C = Lb / e = 1.86 m / 2.20 m 
= 0.845, hence C = 1 (same reduced calculation width for limit active and passive 
earth pressures). 

 

Using the wizard: 
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D.1.2.2. Phase 1 

 In the list of available actions frame, “Earthworks” category, select the Excavation 
option. Transfer  the action and input the excavation level, left: zh = +12.0 m. 

 In the List of available actions frame, “Earthworks” category, select the “Sheeting 
installation” option. Transfer  the action and input the sheeting base: 

z = +12.0 m. 
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D.1.2.3. Phase 2 

To create this new calculation phase and continue to input the phasing data, click . 

 
The first action in the second phase is installation of a Strut:  

 In the List of available actions frame, “Anchors” category, select the “Strut” action and 
transfer  the action. 

 In the “Definition of a strut” frame, fill out the following information: 

o “Activate” a new anchor “left” 

o za = +13.0 m 

o Let us assume HEB 320 struts spaced 4.4 metres axis-to-axis. 

The Young’s modulus of the steel is 210 GPa. Their steel section is 16.130 mm². 
The excavation is assumed to be perfectly symmetric and 20m wide, the useful 
length will thus be half the width of the excavation: Lu = 10 m. 

The stiffness K will be: 

Klayer struts  = E x S / Lu / Esp  
= 2.1 x 10

8
 kN/m² x 16 130 x10

-6
 m² / 10 m / 4.4 m = 76 984 kN/m/ml 

o No pre-stressing in our case: p = 0 kN/ml 

o We will consider a nil inclination for the strut: α = 0° 

o Only leave the “Operate under compression” box ticked (the strut will not be 
authorised to operate under traction).  
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The second action of the 2nd phase is excavation with installation of sheeting. To model this, 
two actions must be used: the Excavation action followed by the Sheeting installation 
action: 

 Define the Excavation action, enter the bottom of excavation level at +8.0 m. 

 Then apply the Sheeting installation action and input the parameters necessary to 
define it, that is the level of the bottom of sheeting installation at the end of the 
excavation phase (here +8.0 m, default value proposed). In the upper part of the wall 
(between level +8.0 and the top of the wall), the wall is thus considered to be 
continuous and the R and C coefficients do not apply to this part anymore. 
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D.1.2.4. Phase 3 

To create this new calculation phase and continue to input the phasing data, click . 

 
Using the operations described in phase 2, install a strut with: 

 Level: za = +9 m 

 Stiffness: K = 76 984 kN/m/ml 

 Pre-stressing: P = 0 kN/ml 

 Inclination: α= 0° 

 “Operate under compression” only. 

 
Then model an excavation with installation of sheeting down to height z = +5.0 m. 
 

 
 
Save your project. 
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D.1.3. Step 3: Calculations and results 

To start the calculations once all project parameters have been input, click the “Calculate” 
button on the buttons bar: 

 

Note: the calculations can be started at any moment once the project, soil and wall 
characteristics have been saved. 
 
The displacement, shear forces and bending moments curve appear on the tab for the phase 
in progress. The results of the various phases can be viewed by switching from one tab to 
another. 
 
To consult all the results proposed in K-Réa in greater detail, click the following button: 

 

Then click the “Phase 1” tab. 

The results of phase 1 appear in graphic form. 

They give the displacements, moments, shear forces and earth and water pressures 
("differential” or “decomposed” pressures). The minimum and maximum values obtained are 
shown below each curve. 
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The shape of the curve clearly corresponds to the behaviour of a cantilever wall. 

The maximum displacement obtained in phase 1 is less than 1 cm. The maximum moment is 
16 kN.m/ml. The maximum shear force is 17.5 kN/ml. 

The last curve on the right shows either the differential pressure (resultant of earth and water 
pressures), or the separate earth and water pressure terms on either side of the wall. the 
screenshot illustrates the “differential” option. 

It is also possible to switch to a results display in table format (at top-left of the window). 
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Then click the "Phase 3" tab to view the results of the last phase. 
 

 
 

The maximum displacement obtained in phase 3 is about 1 cm. 

The maximum moment is 73 kN.m/ml, i.e. 73 kN.m/ml x 2.2 m = 160.6 kN.m per steel 
section, corresponding to a stress of 67 MPa. 

 

Forces taken up by the struts 

The maximum axial forces taken up by the struts reach 75 kN/ml for the upper layer in phase 
2 and 153 kN/ml for the lower layer in phase 3: they can both be found on the shear forces 
curve (peaks at levels +173.0 m and +169.0 m). 

The maximum axial force on the upper layer is obtained in phase 2, at about 75 kN/ml, i.e. a 
force per strut of 75 kN/ml x 4.4 m = 330 kN/strut. 

The maximum axial force on the lower layer is obtained in phase 3, at about 153 kN/ml, i.e. a 
force per strut of 153 kN/ml x 4.4 m ≈ 673 kN/strut. 

These forces are acceptable given the compression and buckling resistance. 

 

Passive earth pressure ratio 

The passive earth pressure ratio remains greater than 2, which is usually acceptable for this 
type of structure. 
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2 additional tabs can then be used to access summary results: 
 

 Results synthesis: this screen gives the main results obtained for each phase and 
the extreme values obtained for the entire phasing, in table format. This table gives a 
rapid overview of the maximum values of displacements, moments, forces in the 
anchors, etc., but can also be used to easily check in which phase(s) the various 
extreme values are reached. 

 
 

 Envelope phases 1 to 3: this screen (with display either in curve or table format) 
shows the envelope curves for displacements, moments and shear forces. In our 
example, we submitted no particular request and the envelope curves presented were 
thus calculated for the entire phasing (phases 1 to 3).  
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D.1.4. Appendix: Processing of pmax 

 
In the case of a composite wall, the limit passive earth pressure is bounded at pmax per 
element, or R x pmax for an equivalent continuous wall. 
 
pmax corresponds to the soil limit pressure (ULS case) or the creep pressure (SLS case). 
 
We will intentionally reduce the value of pmax for the Sands layer (where the passive earth 
pressure develops) in order to illustrate the capping of the passive earth pressure at R x pmax. 
 
We thus define a value of pmax = 60 kPa for the Sands layer in the Soil layers window 
accessible in the Data menu. 
 

   
 

 Pressure profile before reduction of pmax Pressure profile after reduction of pmax 

 
We observe that the mobilised passive earth pressure was indeed capped at: 

R x pmax = 0.845 x 60 kN/m² = 50.7 kN/m/ml 
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 D.2. Tutorial 2: Excavation with struts and drawdown of water level 

 
The example studied is that of an excavation with struts consisting of two parallel diaphragm 
walls joined by 1 layer of temporary struts in the transitory phase and 2 concrete slabs in the 
final phase. 
 
 

 
 
The GL level is initially at +12.0 AOD. 
 
We will proceed with several steps in order to assess the effect of the hydraulic gradient and 
that of the symmetry/asymmetry of the model. 
 

 Step 1: Case of a perfectly symmetric cross-section without gradient;  

 Step 2: With gradient related to drawdown of water level; 

 Step 3: Switch to a double-wall calculation; 

 Step 4: Asymmetric cross-section. 

 
The diaphragm walls have a thickness of 82 cm and are concreted over a total height of 
17m. The top level (AS) of the walls is planned at +7.0 AOD, the bottom level (AI) at 
-10.0 AOD.  
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The earthworks sequence includes an initial excavation phase prior to drilling and concreting 
of the diaphragm wall. This implies creating a 3H/2V bank 5 m high, the base of which is 
situated at 2 m from the top of the walls. 

The phasing comprises 7 successive steps with installation of temporary and final anchors: 

 1 layer of temporary struts 

 2 final anchor levels: 

o Covering slab: 0.50 m thick 

o Base slab: 1.0 m thick 
 
The level of the water table is at +5.0 AOD before the work starts. The level will then be 
systematically lowered 1 metre below the bottom of excavation level.  
 
The concrete used will be of type C25/30. The concrete modulus is taken as equal to 20 GPa 
in the transitory phases and 10 GPa over the long-term. 

 

D.2.1. Step 1: Symmetric cross-section without gradient 

D.2.1.1. Project definition: Title and options 
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Specific parameters to be defined: 

 

 In the Project type frame (right), select “Simple wall”. 

 In the Units frame, choose the units system for your project, by ticking “Metric, kN, 
kN/m2”. 

 Definition of the project in “Levels”, enabling the vertical axis to be directed 
upwards. 

 Additional checks: untick the “Perform the ULS checks” box. 

 In the Calculation options frame, keep the default settings: 100 iterations per 
calculation phase and a calculation step of 0.2 m for the wall. 

o Advanced calculation options: Choose the bank/berm calculation method 
as “Simplified Method”. 

 In the Water options frame, leave the water weight equal to 10.00 kN/m³. Select 
“Pressures” as the hydraulic gradient definition mode (which will not affect the 
calculations because the project is above the water table). 

 Click the  button. 

 

D.2.1.2. Definition of soil layers 

 
The general characteristics of the three layers concerned by the exercise are summarised in 
the following table. 
 

Layer 
γ 

(kN/m
3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kPa) 

dc 
(kN/m²/ml) 

δa/φ 
(-) 

δp/φ 
(-) 

kh 

(kN/m²/ml) 

Bank 18 9 33 0 0 0.667 -0.667 10 000 

Sandy loam 20 10 30 5 0 0.667 -0.667 8 000 

Fine sands  20 10 33 1 0 0.667 -0.667 25 000 

 
Then use the K-Réa wizards to calculate the parameters used to constitute the behaviour law 
for each layer. 
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The following parameters are obtained using the wizards. 
 

Layer 
k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 

Bank 0.455 0.249 6.416 0 0 

Sandy loam 0.500 0.282 4.980 1.238 6.293 

Fine sand  0.455 0.249 6.416 1.154 7.169 

 
The other parameters remain at their default values. For this, leave the Modify advanced 
parameters box unticked. 
 
The following screen is then obtained: 
 

 
 

Click  . 

 
  



  D – Tutorial Manual K-Réa v4 

 

 

Copyright  K-Réa v4 – 2016 – June 2016 Edition  29/107 

D.2.1.3. Definition of the wall 

The following table specifies the characteristics of the wall. 
 

Section 

z0 
Upper 
level  

(AOD) 

z,base 
Lower 
level  

(AOD) 

E 
Young’s 
modulus 
(kN/m²) 

e 
Thickness(m) 

EI 
(kNm²/ml) 

W 

(kN/m²) 

1 +7.0 -10.0 2 x 10+7 0.82 918 947 20.5 

 
The following screenshot illustrates the operations required in K-Réa. 
 

 
 
 

Finally, click  to confirm the values input and make them appear with on graphic 

representation of the project initial data. 
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D.2.1.4. Definition of phasing 

The actions to be considered in each calculation phase must now be defined:  
 

PHASE ACTIONS 

TRANSITORY  
PHASES  

Initial 
 Initial earthworks left of the wall in the form of a bank. 

 Initial earthworks right of the wall at +7.0 AOD. 

1 

 Earthworks right-hand side at +3.0 AOD. 

 Drawdown water level right-hand side at +2.5 AOD. 

 Boussinesq overload of 20 kN/m/ml at 10.5 metres behind the 
wall over a width of 4 metres. 

2 

 Installation of a horizontal layer of struts at +3.5 AOD without pre-
loading (K = 50 000 kN/m/ml) 

 Earthworks right-hand side to bottom of excavation at -2.0 AOD. 

 Drawdown water level right-hand side at -3.0 AOD. 

3 
 Pouring of base slab concrete: we consider only its weight but not 

yet its stiffness. 

 Pumping to -3.0 AOD operational until end of earthworks (safety). 

4 
 Activation of base slab stiffness (ks = 2 860 000 kN/m²/ml). 

 Pumping to -3.0 AOD still operational. 

5 

 Construction of cover slab 
(ks = 2 860 000 kN/m²/ml) 

 Removal of the layer of struts. 

 Pumping to -3.0 AOD still operational. 

SERVICE 
PHASES  

6  Start-up of the structure + Stop pumping 

7  Concrete creep in diaphragm walls and slabs 

 
 
Comments: 
 
In general, the effect of a hydraulic gradient (or excess pore-pressure) must be taken into 
account in transitory situations, unless its effect is favourable. 
 
In our case, stopping pumping has a favourable effect for the design of the diaphragm wall. 
Permanent conditions will not be reached immediately after pouring of the base slab (actual 
end of pumping), which is why we continue to simulate the presence of the gradient until the 
end of the earthworks (conservative approach). 
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D.2.1.4.1. Initial phase 

The initial soil is assumed to be horizontal to the right of the wall. However a bank is defined 
to the left of the wall. 

 “Excavation” action on the left of “Bank” type: 
o zh = +7.0 AOD  zt = +12.0 AOD 
o a = 9.5 m  b = 2.0 m  αe = 1.0 

 “Excavation” action on the right: zh =+7.0 AOD 
 

 
 
 

D.2.1.4.2. Phase 1: Excavation 

 “Excavation” action on the right: zh = +3.0 AOD 

 “Hydraulic action” on the right: zw = +2.5 AOD 

 “Boussinesq overload” action on the left (crane overload): 
o z = +12.0 AOD x = 10.50 m 
o L = 4.0 m  q = 20 kN/m/ml αe = 1.087 
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D.2.1.4.3. Phase 2: Installing layer of struts + Excavation  

 “Strut” action on the right with: 

o za = +3.50 AOD K = 50 000 kN/m/ml 

o P = 0 kN/ml  α = 0° 

 “Excavation” action on the right: zh = -2.0 AOD 

 “Hydraulic action” on the right: zw = -3.0 AOD 

 

 
 

D.2.1.4.4. Phase 3: Pouring base slab 

 “Caquot overload” action on the right: 

o z = -2.0 AOD  q = 25 kN/m/ml 
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D.2.1.4.5. Phase 4: Base slab setting 

 “Surface strut” (base slab) action on the right: 
o zsup = -1.0 AOD  zinf = -2.0 AOD 
o ks = 2 860 000 kN/m²/ml ps = 0 kN/m/ml 

 

 
 
 

D.2.1.4.6. Phase 5: Removal of the layer of struts + construction of cover slab 

 “Surface strut” (cover slab) action on the right: 
o zsup = +7.0 AOD  zinf = +6.50 AOD 
o ks = 2 860 000 kN/m²/ml ps = 0 kN/m/ml 

 “Strut” action: deactivate the layer of struts 
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D.2.1.4.7. Phase 6: Start-up of the structure and stop of the pumping 

 

 “Caquot overload” action: 
o Modify overload n°1 (Phase 3) q = 70 kN/m/ml 

 “Hydraulic action” to the right with a hydraulic gradient: 
o zw = -2.0 AOD 
o Tick “Definition of a gradient” 

 

Level (m) Pressure (kN/m/ml) 

-2 70.0 

-10 150.0 
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D.2.1.4.8. Phase 7: Creep 

 

 “Modification of wall bending stiffness” action: 
o z1 = +7.0 m   z2 = -10.0 m 
o EI = 459 473 kNm²/ml W = 20.5 kN/m/ml 

With the wizard: 
o Young’s modulus = 10 GPa = 1 x 10+7 kN/m² 
o Thickness = 0.82 m 

 

 “Surface strut” action: 
o Modify surface strut n°1 ks = 1 430 000 kN/m²/ml 

 

 “Surface strut” action: 
o Modify surface strut n°2 ks = 1 430 000 kN/m²/ml 

 

 
 

  
 
 
Activate calculation of forces envelope by ticking the “Envelope” check box in Phase 5. 
 
Save your project.  
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D.2.1.5. Calculation and results 

 

Start the calculation by clicking the  button. 

The results are now available and can be accessed with the  button. 
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During this first step, we obtain the following “envelope” results: 
 
 Transitory Phases  Final Phases  

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 1.7 cm 1.9 cm 

Bending moment  520 kN.m/ml 540 kN.m/ml 

Shear force 250 kN/ml 230 kN/ml 

Passive earth pressures 
ratio 

2.0 2.3 
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D.2.2. Step 2: Taking account of hydraulic gradient 

In this 2nd step, we model the hydraulic gradient generated by drawdown of the water table in 
each calculation phase.  

Click the “File” menu and select “Save as…”. 

For example, name the file in the following way: “Example 2 – Step 2”. 

 

D.2.2.1. About the hydraulic gradient  

D.2.2.1.1. Theory reminder 

Drawdown of the water level is accompanied by the development of a flow field around the 
wall base, which aims to restore the continuity of the hydraulic head between the two sides of 
the wall. Along a “stream” line, the hydraulic head varies continuously between that 
corresponding to the initial water level (soil side) and that corresponding to the imposed level 
at the bottom of the excavation. 

In the case of this exercise, we assume that the permeability levels of the fine sands and 
loam (k2 and k3) are comparable. The permeability of the bank (k1) is assumed to be high by 
comparison with k2 and k3. The bank thus acts as an “open” horizon. The flow regime thus 
develops from the base of the bank (+2.00 AOD) as shown in the following figure. 

 

  

The following figure illustrates the flow field which develops in the soil in the case of a 
homogeneous soil. This is characterised by: 

 Equipotential lines (continuous curves): set of points in the medium with the same 
potential. 

 Streamlines (dotted curves): trajectories of water particles subject to flow forces. 

In the case of a wall calculation based on the reaction coefficients model, processing of the 
flow regime is limited to taking account of the pore pressure field located in the following 
rectangle. 
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By comparison with the hydrostatic regime in which all the points (on the same side of the 
wall) are associated with the same hydraulic head (corresponding to the top of the water 
table on the side concerned), the development of the flow regime leads to a hydraulic head 
that varies with depth on each side of the wall. 

 

The pore pressure at a given point is linked to the hydraulic head by means of the following 
relation: 

𝑢𝐴 = (ℎ𝐴 − 𝑧𝐴) ∙ 𝛾𝑤 

Where 𝛾𝑤 is the specific weight of water. 
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D.2.2.1.2. Calculation of hydraulic gradient 

The hypothesis k2 ~ k3 compares the soil in which the flow regime is developing to a 
homogeneous single layer resting on a watertight base. This enables the Mandel model to be 
applied for estimation of the hydraulic head at the foot of the wall HA.  

 
 

 H100 hydraulic head on soil side (corresponding to initial water table level) 

 H0 hydraulic head on excavation side 

 ΔH total head loss 

 e1 total thickness of ground on soil side down to top of watertight base 

 f1 thickness of ground on soil side down to the base of the wall  

 e2 total thickness of ground on excavation side down to the top of the watertight 
  base 

 f2 thickness of ground land on excavation side down to the base of the wall  

 HA hydraulic head at base of wall 
 
Where the “ground” refers to the medium in which the flow develops (in our case, the loam + 
dense sands assembly). 
 
The hydraulic head at the base of the wall is estimated using the relation: 
 

𝐻𝐴 = 𝐻0 +
𝜌2

𝜌1 + 𝜌2

(𝐻100 − 𝐻0) 

With : 

- 𝜌𝑖 = 𝜋 (2 ∙ 𝑙𝑛 {2 ∙  𝑐𝑜𝑡𝑔(
𝜋

4
∙

𝑓𝑖

𝑒𝑖
})⁄  for 

𝑓𝑖

𝑒𝑖
≤ 0.5 

- 𝜌𝑖 =
2

𝜋 
𝑙𝑛 {2 ∙  𝑐𝑜𝑡𝑔(

𝜋

4
∙ (1 −

𝑓𝑖

𝑒𝑖
)} for  

𝑓𝑖

𝑒𝑖
> 0.5 

 
 

Application to the project studied – case of phase 3 
 

 H100 = +5.0 m (level of water table on left-hand side) 

 H0 = -3.0 m (level of drawdown on excavation side) 

 ΔH = +5.0 – (-3.0) = 8 m 

 f1 = +2.0 – (-10.0) = 12 m 

 e1 = +2.0 – (-15.0) = 17 m 

 f2 = -3.0 – (-10.0) = 7 m 

 e2 = -3.0 – (-15.0) = 12 m 
 



  D – Tutorial Manual K-Réa v4 

 

 

Copyright  K-Réa v4 – 2016 – June 2016 Edition  41/107 

 
𝑓1

𝑒1
=  

12

17
= 0.706 > 0.5      →        𝜌1 =

2

𝜋 
𝑙𝑛 {2 ∙  𝑐𝑜𝑡𝑔(

𝜋

4
∙ (1 −

𝑓1

𝑒1
)} ≈ 1.4 

 
𝑓2

𝑒2
=  

7

12
= 0.583 > 0.5      →        𝜌2 =

2

𝜋 
𝑙𝑛 {2 ∙  𝑐𝑜𝑡𝑔(

𝜋

4
∙ (1 −

𝑓1

𝑒1
)} ≈ 1.1 

 

𝑯𝑨 = 𝐻0 +
𝜌2

𝜌1 + 𝜌2

(𝐻100 − 𝐻0) = −3 +
1.1

1.4 + 1.1
(5 − (−3)) ≈ +𝟎. 𝟓𝒎 

 
The pore pressure at the base of the wall will be: 
 

𝒖𝑨 = (𝐻𝐴 − 𝑧𝐴) ∙ 𝛾𝑤 = (0.5 − (−10.0)) ∙ 10 𝑘𝑁/𝑚³ = 105 𝑘𝑃𝑎 ≈ 𝟏𝟎𝟓 𝒌𝑷𝒂 

 
The following figure presents the “average” profile of the pore pressures on each side of the 
wall, superposed over that of the hydrostatic regime.  
 

 
 
Note 1: It should be noted that in the absence of a watertight base, application of the Mandel 
model leads to HA = (H100+H0) / 2 = 1.00 m and uA = 110 kPa. 
 
Note 2: In practice, a hydrostatic regime is considered on the soil side, even in the presence 
of a flow regime (conservative approach).  
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D.2.2.1.3. Definition of hydraulic gradient with K-Réa 

The hydraulic gradient can be modelled in K-Réa in two ways:  

 Option 1: definition of a pressure profile (z, u(z)); 

 

 

 

 Option 2: definition of a hydraulic potential (or head) profile (u, h(z)) 
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D.2.2.1.4. Phasing 

Taking account of the hydraulic gradient requires that the following modifications be made. 
 
Phases 1 and 2: 
 

  “Hydraulic action” on the right with “definition of a gradient”: 
 

Phase 1: zw = +2.50 m Phase 2: zw = -3.0 m 

Level 
(m) 

Pressure 
(kN/m/ml) 

+2.5 0.0 
-10.0 137.3 

 

Level 
(m) 

Pressure 
(kN/m/ml) 

-3.0 0.0 
-10.0 105.0 
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D.2.2.2. Calculation and results 

Restart the calculation and access the results. The following figure presents a summary of 
the results obtained. 
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During this 2nd step, we obtain the following “envelope” results: 
 
 Transitory phases  Final phases  

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 1.8 cm 2.0 cm 

Bending moment  560 kNm/ml 580 kNm/ml 

Shear force 270 kN/ml 230 kN/ml 

Ratio of passive earth 
pressures 

1.5 2.3 

 
 
We note that in the transitory phase, the ratio of passive earth pressures is lower than that 
obtained in step 1 (1.5 < 2.0). This can be explained by the reduction in the effective stress 
on the excavation side, itself generated by the increased water pressure owing to flow. 
 
We observed that taking account of a flow increases the loadings on the wall. The maximum 
bending moment and shear force rose between steps 1 and 2. The maximum increase is 
about 8%. 
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D.2.3. Step 3: Switch to a double wall calculation 

D.2.3.1. General data 

This step aims to illustrate the equivalence of the previous calculation with that of a perfectly 
symmetric double wall.  

Click “Save as” in the File menu. For example name the file “Example 2 – Step 3”. 

Go to the “Data” menu and click “Title and Options”. In the Project Type part, click “double 
wall”. 

 

 

 

Click  . 

K-Réa then proposes transferring the soil data from wall 1 to wall 2. 

 

 

Click  to automatically copy the soil layers from wall 1 to wall 2. 
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Then click . 

Proceed in the same way to transfer the data from wall 1 to wall 2: click  . 

 

 

 

 

Then click  . 

 

D.2.3.2. Phasing 

The “struts” must now be replaced by “”linking anchors” and the “surface struts” by “slab 
anchors”. 
 
The useful length of these new linking anchors will be the distance between the walls, 14 m. 
 
First of all delete the actions linked to the “strut” and “surface strut” type anchors, beginning 
by those of the “deactivate” type. 
 
Then define the “linking anchors” and the “slab anchors”.  
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Phase 2: 
 
Stiffness of linking anchor: 
 
K = E S / Lu ≈ 25 000 kN/m/ml 
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Phase 4 
 
Stiffness of slab anchor: 
 
ks = E / Lu ≈ 1 430 000 kN/m²/ml 
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Phase 5 
 
Stiffness of slab anchor: 
 
ks = E / Lu ≈ 1 430 000 kN/m²/ml 
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Phase 7 
 
Stiffness of slab anchor: 
 
K = E / Lu ≈ 715 000 kN/m/ml 
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D.2.3.3. Calculation and results 

 
Start the calculation and access the results. These are exactly the same as those from the 
simple wall calculation (because the excavation is perfectly symmetric). 
 

 

 
 
During this 3rd step, we obtain “envelope” values that are identical to the 2nd step. The values 
are given below as a reminder: 
 
 Transitory phases  Final phases  

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 1.8 cm 2.0 cm 

Bending moment  560 kNm/ml 580 kNm/ml 

Shear force 270 kN/ml 230 kN/ml 

Ratio of passive earth 
pressures 

1.5 2.3 
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D.2.4. Step 4: Case of an asymmetric excavation 

In this step, we prepare to assess the effect of an asymmetric cross-section by comparison 
with the symmetric cross-section calculated in step 3. 

We intentionally eliminate the bank and the overload at the right-hand side of the right wall 
and the aim will be to compare the results with those of step 3. 
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For this, we will follow the instructions below. 

 

Initial phase: elimination of the bank behind the right-hand diaphragm wall (Wall 2) 

 

Phase 1: elimination of the Boussinesq overload behind the right-hand diaphragm wall 
(Wall 2) 
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Restart the calculation and display the results. 

 

 
 
 
During this 4th step, we obtain the following “envelope” results: 
 
WALL 1 Transitory phases Final phases 

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 2,3 cm 2,6 cm 

Bending moment 560kNm/ml 580 kNm/ml 

Shear force 260 kN/ml 226 kN/ml 

Ratio of passive earth 
pressures 

1.5 2.2 

 
 
WALL 2 Transitory phases Final phases 

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 1.4 cm 1.3 cm 

Bending moment 340 kNm/ml 380 kNm/ml 

Shear force 210 kN/ml 190 kN/ml 

Ratio of passive earth 
pressures 

2.0 3.2 
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Reminder of the symmetric calculation results (step 3): 
 
 Transitory phases Final phases 

 Ph. 1 to 5 Ph. 6 and 7 

Displacement 1.8 cm 2.0 cm 

Bending moment 560 kNm/ml 580 kNm/ml 

Shear force 270 kN/ml 230 kN/ml 

Ratio of passive earth 
pressures 

1.5 2.3 

 
 
Comparison of the displacement curves in phase 5 (end of transitory phases) and phase 7 
(end of service phases) between steps 3 and 4. 
 

  



  D – Tutorial Manual K-Réa v4 

 

 

Copyright  K-Réa v4 – 2016 – June 2016 Edition  57/107 

 D.3. Tutorial 3: Excavation supported by cantilever wall 

 
The example studied is that of a cantilever diaphragm wall 60 cm thick and anchored 6m in 
marly soil. The following figure illustrates the characteristics of the example. 
 

 
 
In this example, we will detail the ULS checks for this type of configuration. 
 
This example will in particular be used as a basis for illustrating the following points: 

 Comparison of different LEM methods proposed in K-Réa; 

 Comparison of weighting systems; 

 Vertical equilibrium and automatic correction of the angle of counter passive earth 
pressure; 

 Effect of over-excavation. 
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D.3.1. Data input 

To start K-Réa: 

 Double-click the K-Réa icon. 

 Choose the appropriate protection mode, select the appropriate language  (French) 
and click OK.  

 Choose New project to access the Title and Options page. 

 

D.3.1.1. Title and options 

 

 
 

 In the Project type frame (right) select “Simple wall”. 

 In the Title / Project number frame, click the blank “Title” line and input the title of 
your choice. Click the blank “Project number” line to enter the number of your choice. 

 In the Units frame, choose the units system of your project, by ticking ‘Metric, kN, 
kN/m2’. 

 Choose Definition of the project in Levels, which enables the vertical axis to be 
directed upwards. 

 Additional checks: tick the “Perform the ULS checks” box to activate calculation at 
the ultimate limit states for this example. 

 In the Curves display frame, keep the “Same horizontal scale for curves” box ticked. 

 Choose the Language for output. 

 In the Calculation options frame, keep the default settings: 100 iterations per 
calculation phase and a calculation step of 0.2 m for the wall. 

 In the Water options frame, leave the water weight at 10.00 kN/m³. Choose 
potentials as the hydraulic gradient definition mode (this will not influence the 
calculations because the project does not include drawdown of the water table). 
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D.3.1.2. Definition of soil layers 

The general characteristics of the two layers of interest for the exercise are summarised in 
the following table. 
 

Layer 
γ 

(kN/m
3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kN/m²) 

dc 
(kPa/m²/m) 

δa/φ 
(-) 

δp/φ 
(-) 

Sands and 
gravel 

20 10 35 0 0 0.66 -0.66 

Soft marls 19 9 23 10 0 0.66 -0.66 

 
Then use the K-Réa wizards to calculate the parameters of the behaviour law for each layer. 
The reaction coefficient kh is to be considered with the values given in the table below.  
 

Layer 
k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 
EM 

(kPa) 
α 
(-) 

kh 

(kN/m
3
) 

Sands and 
gravel 

0.426 0.227 7.301 0 0 20 000 0.33 66 930 

Soft marls 0.609 0.382 3.194 1.452 4.803 19 800 0.66 26 210 

 
The other parameters are kept at their default values. For this, leave the Modify advanced 
parameters box unticked. The following screen illustrates that of K-Réa on completion of 
these operations: 
 

 
 

Click . 

To consult or modify the soil layers subsequently, click the Data menu, then Soil layers. 
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D.3.1.3. Definition of the wall 

After validating the characteristics of the layers, those of the wall must be defined. 

 Click the input box to enter the upper level of the wall: z0 = +0.00 m. 

 Click the first line of the table (corresponding to the first wall section to be defined, 
which will in fact be the only one for this example), enter the base of the section in the 
first column, here level zbase = -13.0 m. 

 Then click the  button to determine the EI product of the wall  

o Choose the Continuous wall tab, then select “Short term concrete (20 GPa)”. 

o Then input the wall thickness e = 0.60 m.  

 Click  then quit the wizard. 

Then fill out the weight per unit area of the wall W = 0.6 m x 25 kN/m3 = 15 kN/m/ml. 
 
The following screenshot illustrates the above operations: 
 

 
 

Finally, click  to take account of the values entered and have them appear with 

the graphic representation of the project initial data.  
 
To edit on the wall characteristics later, click the Data menu, then Retaining wall. 
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D.3.2. Definition of phasing 

The actions to be considered in each construction phase must now be defined.  
 
These actions are summarised in the following table: 
 

PHASE ACTIONS 

Initial  Blank 

Phase 1 
Transitory 

 Excavation to level – 5.00 m 

 Caquot overload on the right of 25 kN/m/ml – variable nature  

Phase 2 
Permanent 

 Modification of Caquot overload 10 kN/m/ml – variable nature  

 Switch to “permanent phase” 

 
 

D.3.2.1. Initial phase 

No action is to be defined in this phase. 
 
 

D.3.2.2. Phase 1 

To create this new calculation phase, click  next to the initial phase tab (“P00”). 

This phase is to be defined as a “transitory phase”. Two actions then need to be defined: 

 “Excavation” action with zh = -5.00 m on the left; 

 “Overload” action with q = 25 kN/m/ml, “variable” nature, applied on the right, at 
z = +0.00. 
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This project (and thus this phase) includes no anchors and the wall is cantilever. Moreover, 
we activated the ULS checks when defining the properties of the project. 

Consequently:  

 The Cantilever wall box is automatically ticked, which implies that a “LEM” model will 
be considered to verify the equilibrium of the wall at ULS; 

 The LEM Options action was automatically added and concerns the following options: 

o Input of over-excavation, left or right (leave at zero for the time being); 

o Choice of the calculation method: automatic or manual (LEM – F / LEM – D 
and choice of calculation level for the base of the wall); 

o Selection of side of passive earth pressure: automatic or manual (left or right); 

o Correction of angle of counter passive earth pressure: automatic / manual. 

These options will be described in detail at the end of the exercise. 

 

 
 

  



  D – Tutorial Manual K-Réa v4 

 

 

Copyright  K-Réa v4 – 2016 – June 2016 Edition  63/107 

D.3.2.3. Phase 2 

Add a new calculation phase by clicking  next to the tab of the previous phase (“P01”). 

This phase is to be defined as “Permanent phase”. 

Modify the “Caquot overload” defined in the previous phase: 

 Density q = 10 kN/m/ml instead of 25 kN/m/ml 

 Nature unchanged (“variable”). 

 

 

 

D.3.3. Calculations and results 

D.3.3.1. Main results 

To start the calculations at the end of input of all project parameters, click “Calculate” on the 
buttons bar: 

 
 
To check all the results proposed in K-Réa in more detail, click button: 

 
 
Then click the "Phase 1" tab. 

We will first of all analyse the “SLS” results: in parallel with the “LEM” calculation, K-Réa also 
gives the results of a SLS calculation based on a “MISS” model. This calculation is in 
particular able to verify the displacements of the wall with respect to the structure’s design 
criteria. Here, the maximum deflection is about 3 cm. 
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We can see that the ratio of passive earth pressures is also displayed at the bottom of the 
graphs (here 2.29): as this is a cantilever wall, this ratio has no physical meaning and should 
not be used to justify the wall embedment depth with respect to the passive earth pressure 
safety check. In this type of configuration, the embedment depth must be justified in 
accordance with the regulations by a limit equilibrium model available by selecting the “ULS” 
option at the top-left of the results window. 

 

 
 
 
The following figure presents the ULS results of phase 1: only the moments, shear forces 
and pressures diagrams are available (no displacements with the LEM model). The forces 
and pressures are expressed directly in calculation values (ULS). The maximum values are 
as follows: 

 Bending moment:  514 kNm/ml at ULS 

 Shear force:   237 kN/ml at ULS 

 Normal force:   190 kN/ml at ULS 

The diagram of soil pressures (right) is an illustration of the principle of the LEM model, 
which consists in working directly with the soil pressure limit values: limit active earth 
pressure on the right (weighted) and limit passive earth pressure on the left (weighted) down 
to the transition point zn. Below this transition point, the counter passive earth pressure is 
(partially) mobilised on the right of the wall and the counter active earth pressure is mobilised 
on the left. 
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In this phase, the passive earth pressure side was automatically chosen by K-Réa as being 
the left side. This automatic choice may be forced by the user in the “LEM options” action 
accessible for each phase in which the wall is declared as cantilever. 

Then access the “Phase 2” tab to view the corresponding ULS results. The Caquot overload 
having been reduced to 10 kN/m/ml in this phase, the amplitude of the loading is reduced 
accordingly. 

 

D.3.3.2. Passive earth pressure safety check 

Now click the “Pass. press.” button to access details of the ULS checks run by K-Réa in 
parallel with the forces calculation. 
We will look at phase 2. The wall embedment depth is conventionally counted as of the null 
differential pressure point z0: fb = z0 - zp. According to the regulations, the justification of the 
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embedment depth with respect to the passive earth pressure safety check requires that this 
be at least equal to 1.2 times the critical embedment depth f0 allowing equilibrium of the 
moments. In this case, we have fb = 1.15 f0 < 1.20 f0. The wall embedment depth is therefore 
insufficient with respect to the passive earth pressure safety check. Elongation of the 
embedment depth is necessary in order to meet the regulatory requirements. 
 

 
 
Return to the “Data” menu and then the “Retaining wall” tab, in order to extend the 
embedment depth. Modify the level of the base to -13.50 m instead of -13.00 m. 
 

 
 
Restart the calculation and click the “EC7 checkings” tab. 
 
Let’s check phase 2. The following figure summarizes the meaning of the intermediate 
parameters used in the LEM model: 

 The null differential pressure point:   z0 = - 5.21 m 

 The critical point allowing equilibrium of moments:  zc = -12.00 m 

 The available wall embedment depth as of point z0:   fb = z0 - zp = 8.29 m 

 The critical embedment depth allowing equilibrium of moments: f0 = z0 – zc = 6.79 m 
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The following figure provides the details of the check of the passive earth pressures for this 
phase. In the present case, we have fb = 1.22 f0. The wall embedment depth is thus optimum 
for the passive earth pressure safety check. 
 
This verification is supplemented by that of the counter passive earth pressure: the aim is to 
check that the counter passive earth pressure available (Cm,d) below the transition point zn 
(= -11.03 m here) is greater than that required for equilibrium of forces (Ct,d). This condition 
is equivalent to that of a mobilisation factor α ≤ 1. It is met in the case of this example. 
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D.3.3.3. Vertical equilibrium 

 
Still in “ULS checks” now click “Vert. eq.” to access the verification of the vertical forces 
equilibrium. This verification has a dual purpose: 

 To examine the relevance of the assumptions considered for the active/passive earth 
pressures; 

 To examine the wall bearing capacity as a deep foundation element: it is the 
responsibility of the user to check that the stress at the base of the wall is compatible 
with the soil resistance. 

 
As shown in the following figure, this verification involves the following intermediate 
parameters: 

 Vertical resultant force of earth pressures: Pv,d = 81 kN/ml; 

 Vertical resultants of external forces Fv,d and of anchors Tv,d: null in the present 
exercise; 

 Weight of the wall: P,d = 1.35 x 13.5 x 15 = 273 kN/ml 

 
All of these forces are expressed in calculation values. In particular in the context of 
approach 2, the weight of the wall is multiplied by 1.35. 
 

 
 

The above window also shows a factor Xcb, known as the “Correction factor of the inclination 
of the counter earth pressure” the meaning of which will be detailed in the next chapter.  
 
 

D.3.4. Parametric study 

The subject of this chapter is to illustrate the role played by each of the “LEM Options” in the 
context of a cantilever wall. The following paragraphs are to be dealt with independently. 
 

D.3.4.1. Correction of active/passive earth pressure angles 

In this paragraph, we will look at the “automatic correction of the angle of counter passive 
earth pressure” option (accessible from the “LEM options” action, which appears 
automatically for each phase declared to be “Cantilever”). 
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This option allows automatic readjustment of the counter passive earth pressure angles if the 
vertical equilibrium verification leads to an upwards resultant. The counter earth pressure 
angle considered in the calculation is as follows:  

 
(δ/φ)counter passive earth pressure  = Xcb x (δ/φ)passive earth pressure 

 
The Xcb factor has an initial value of 1.00 and is then gradually reduced (if necessary) until a 
downwards vertical resultant is obtained. The process stops in any case when Xcb reaches 
the value of -1.00. It should be noted that the modification of the angle of counter passive 
earth pressure involves that of the counter passive earth pressure coefficients kp,cb and kpc,cb 
which are used in the calculation of the counter passive earth pressure available below 
transition point zn. These coefficients are automatically recalculated by the programme using 
the “reference” calculation method designated by the user (by default “Kérisel and Absi”). 
 
In the previous exercise, the vertical verification led to a downwards resultant with Xcb = 1. 
The fact of obtaining Xcb = 1.00 implicitly means that no correction of the counter passive 
earth pressure angles was considered to be necessary by the programme. 
 

In order to illustrate the effect of this automatic correction, we propose restarting the wall 
calculation, ignoring its own weight. To do this, go to the “Data” menu and click “Retaining 
wall”: then set W = 0. 

 

 
 

Restart the calculation and directly access the “EC7 checkings” / “Verif. Eq.”.  
 
Let us examine the case of phase 2 for example. The value obtained for Xcb is -0.44 < 0. It 
should be recalled that, in this exercise, the angle of the passive earth limit pressures was 
taken at -2/3φ (upwards). Obtaining a negative value for Xcb therefore means that the 
automatic correction process led to the counter passive earth pressure being directed 
downwards with an angle of -0.44 x -2/3φ = + 0.29φ for the levels situated below the 
transition point z < zn = -11.04 m. 
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By accessing the “Passive earth pressure safety check”, it can be checked that the available 
counter passive earth pressure resultant Cm,d below the transition point has changed 
(dropped) by comparison with the initial calculation result: 

 With the weight of the wall: 

Xcb = +1.00 and Cm,d = 1138 kN/ml 

 

 With the weight of the wall: 

Xcb = -0.44 and Cm,d = 682 kN/ml 

 
The reduction in Cm,d can be explained by the programme reassessing the limit counter 
passive earth pressure coefficients kp,cb:  kp,cb (δ/φ = +0.29) < kp,cb (δ/φ = -0.66). 
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D.3.4.2. Comparison of LEM models “F” and “D” 

In this paragraph, we propose comparing the calculation scenarios proposed by K-Réa for a 
limit equilibrium calculation (LEM). 
 

Caution: when carrying out this parametric study, one must start with the basic model. 

 
K-Réa proposes two calculation methods: 

 Method F: this is based on the assumption of a counter passive earth pressure 
comparable to a uniform additional pressure applied between levels z = zc + 0.2f0 and 
z = zc – 0.2f0. The value of this additional pressure is sought so that limit equilibrium 
between the forces is obtained;  

 Method D (default choice): this is based on the assumption of a counter passive earth 
pressure calculated as a fraction α of the mobilisable (or limit) counter passive earth 
pressure below transition point zn. The values of α and zn are sought simultaneously 
so as to obtain the (limit) equilibrium of the moments and forces over the height of the 
wall (two equations, two unknowns). 

 
The “effective” level zeff of the base of the wall considered in the calculation differs from one 
method to the other: 

 LEM – F: zeff = zc – 0.2f0; 

 LEM – D, three options are available: 

o zeff = zbase (default option); 

o zeff = zc – 0.2f0; 

o zeff = zuser (imposed by the user). 

 
Go to “LEM option” in phase 2 and untick the “Automatic” box in “Calculation method”, then 
select “Method F”. 
 

 
 
Start the calculation and compare the results obtained (moment diagrams, details of ULS 
checks) with those of a LEM-D calculation. The following table summarises this comparison. 
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Mmax 

(kNm/ml) 
Vmax 

(kN/ml) 

zc 
(m) 

zn 

(m) 
f0 

(m) 
Cm,d 

(kN/ml) 
Ct,d 

(kN/ml) 

Method F 406 140 -12.00 - 6.79 645 272 

Method D 406 176 -12.00 -11.04 6.79 1138 272 

 
The two methods lead strictly to the same maximum moment, at the same critical point and 
therefore the same critical embedment depth f0. The resultant of the mobilised passive earth 
pressure (that necessary to balance the forces) is identical with the two approaches.  
However, the calculation height for the counter passive earth pressure differs owing to the 
construction of the two methods, hence a difference in the value of the mobilisable passive 
earth pressure Cm.d. We also observe a difference in the shear force which can be explained 
by the approximation made with method F on the “uniform” distribution of the additional 
counter passive earth pressure.  
 
The following graphs compare the diagrams of moments, shear forces and differential 
pressures from the two methods. They corroborate the findings in the previous table. 
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D.3.4.3. Influence of over-excavation 

In this paragraph, we will look at the “over-excavation” option in K-Réa. Taking account of 
over-excavation in the ULS justifications is required by the regulations if there is no strict 
inspection of the bottom of the excavation. In this case, it is taken as being equal to: 

Δaleft = min (50 cm; 10% Hsupported) = 50 cm 

Caution: when dealing with this parametric study, it is necessary to start with the basic 
model. 

 
We thus propose restarting the calculation assuming an over-excavation of 50 cm on the left, 
in phases 1 and 2. 

 

The result of the EC7 checkings indicates that the wall embedment depth is no longer 
sufficient and that an extension of the wall is therefore necessary in these conditions. 

 

The search for the optimum embedment depth shows that the verification of the passive 
earth pressure safety check taking account of an over-excavation of 0.5 m requires extension 
of the wall by 1.50 m by comparison with the length initially validated in the absence of over-
excavation. The result obtained with a wall base at -15.00 is presented below. 
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D.3.4.4. Comparison of calculation approaches 2 and 3 

 
The previous ULS results were obtained by applying approach 2 required by the French 
standard for ULS – GEO and ULS – STR verifications.  
 
We propose comparing the previous results with those taken from application of approach 3 
in Eurocode 7 (applied by other European countries). To do this, simply go to “Title and 
options” and select approach 3 from the “Partial factors” drop-down list. 
 

Caution: when dealing with this parametric study, it is necessary to start with the basic 
model. 

 
Then restart the calculations and compare the results with those obtained previously. 
 

 
 
The following graphs illustrate this comparison for phase 2, in which the two approaches 
would appear to lead to comparable results for a “permanent” phase.  
 

 
 
 
However, approach 3 is unable to differentiate the transitory phases from the permanent 
phases (approach 2 considers a smaller safety margin on the passive earth pressure in the 
case of a transitory phase). The comparison with approach 2 in phase 1 (transitory) therefore 
gives diverging results. Approach 3 leads to more unfavourable results. 
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 D.4. Tutorial 4: Excavation with anchors and stability of anchor block 

 
This example presents the calculation of a diaphragm wall 1.0 m thick, which descends to a 
depth of 22 m and is anchored by two layers of bedded anchors angled 30° from the 
horizontal. 
 
The length of the bedding of the anchors is set at 10 m. The mesh of the lower anchors is 
about 1.50 times denser than that of the upper anchors. We initially assume a free length of 
7 m for all the anchors, which corresponds to a “useful” length of 7 + 10/2 = 12 m.  
 
The following figure gives a schematic representation of the geometry of the problem 
studied. 
 

 
 

 
This example mainly aims to demonstrate the K-Réa functionalities linked to the ULS checks 
according to EC7, more specifically with regard to the stability of the anchor block in the case 
of a wall anchored by one or more layers of bedded anchors.  
 
 

D.4.1. Data input 

To start K-Réa: 

 Double-click the K-Réa icon. 

 Choose the appropriate protection mode, keep the select the appropriate language  
(French) and click OK.  

 Choose New project to access the Title and Options page. 
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D.4.1.1. Title and options 

 

 
 

 In the Project type frame (right), select “Simple wall”. 

 In the Title / Project number frame, click on the blank “Title” line and enter the title of 
your choice. 

Click on the blank “Project number” line to enter the number of your choice. 

 In the Units frame, choose the units system of your project, by ticking ‘Metric. kN. 
kN/m2’. 

 Choose Definition of the project in Levels, which enables the vertical axis to be 
directed upwards. 

 Additional checks: tick the “Perform the ULS checks” box to activate the calculation 
at the ultimate limit states for this example. 

 In the Curves display frame, keep the ”Same horizontal scale for curves” box ticked. 

 Choose the Language for output. 

 In the Calculation options frame, keep the default settings: 100 iterations per 
calculation phase and a calculation step of 0.2 m for the wall. 

 In the Water options frame, leave the water weight equal to 10.00 kN/m³. Choose 
Potentials as the definition mode for the hydraulic gradient  

 Click the  button. 

 K-Réa then asks you to save the new project: define the name and directory. 
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D.4.1.2. Definition of soil layers 

The general characteristics of the 4 layers of interest for the exercise are summarised in the 
following table. 
 

Layer 
γ 

(kN/m
3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kPa) 

dc 
(kN/m²/ml) 

δa/φ 
(-) 

δp/φ 
(-) 

EM 
(MPa) 

α 
(-) 

Backfill 18 10 30 0 0 0.66 -0.66 10 0.50 

Silt 20 10 35 0 0 0.66 -0.66 20 0.33 

Sandy 
clays  

20 10 28 0 0 0.66 -0.66 8 0.67 

Marly 
limestone 

22 12 30 40 0 0.66 -0.66 40 0.50 

 
 
Then use the K-Réa wizards to calculate the parameters for constituting the behaviour law 
for each layer.  
 
The reaction coefficient kh is evaluated using the Schmitt model, considering a product of 
inertia EI = 1 667 MNm²/ml (calculated for a continuous wall 1m thick, with E = 20 GPa). 
 
The parameters obtained using the wizards are as follows.  
 

Layer 
k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 
kh 

(kN/m
3
) 

Backfill 0.500 0.283 4.959 0 0 9 158 

Silt 0.426 0.227 7.301 0 0 40 158 

Sandy clays 0.531 0.309 4.398 0 0 4 604 

Marly 
limestone 

0.500 0.283 4.959 1.237 6.271 58 148 

 
 
The other values keep their default values. For this, leave the Modify advanced parameters 
box unticked. 
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The following screenshot illustrates that of K-Réa following these operations: 
 

 
 

Click  . 

 

D.4.1.3. Retaining wall 

After validating the characteristics of the layers, those of the wall must be defined: 

 Wall top level:  z0 = +0.00 m 

 Wall bottom level:  zbase = -22.0 m 

 Product of inertia:  EI = 1 666 667 kNm²/ml 

 Weight per unit area:  W = 25 kN/m/ml 

 
The following screenshot illustrates the previous operations: 
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D.4.2. Definition of phasing 

We must now define the actions to be considered in each construction phase. These actions 
are summarised in the following table.  
 

PHASE ACTIONS 

Initial  Existing Boussinesq overload of 20 kN/m/ml 

Phase 1 - Transitory  Excavation to level -5.00 m 

Phase 2 - Transitory  First layer of active anchors at -4.00 m 

Phase 3 - Transitory  Excavation to level -9.00 m 

Phase 4 - Transitory  Second layer of active anchors at -8.00 m 

Phase 5 - Permanent  Excavation to level -14.00 m 

Phase 6 - Permanent  Wall creep (E = 10 GPa) 

 
 

D.4.2.1. Initial phase 

In this phase, we define an initial localised overload representative of an existing building. 
Define the following: 

 Boussinesq overload action with 

o z = -1.00 x = 7.00 m 

o L = 10 m q = 20 kN/m/ml 

o Permanent action nature 
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D.4.2.2. Phase 1: Excavation to level -5.00 

This phase is to be defined as a “transitory phase”. A single action is to be input: 

 “Excavation” action on left with zh = -5.00; 

 

The “Cantilever wall” box is automatically ticked: the ULS equilibrium of the wall will thus be 
checked by a “LEM” model in this phase.  

D.4.2.3. Phase 2: Anchors at level -4.00 

This phase is to be defined as a “transitory phase”. A single action is to be input:  

 “Anchor” action to the right at za = -4.00 with: 

o K = 12 500 kN/m/ml P = 150 kN/ml α = 30° Lu =12 m Ls = 10 m 
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D.4.2.4. Phase 3: Excavation to level -9.00 

This phase is to be defined as a “transitory phase”. A single action is to be input: 

 “Excavation” action on left with zh = -9.00  

 
 

D.4.2.5. Phase 4: Anchors at level -8.00 

This phase is to be defined as a “transitory phase”. A single action is to be input: 

 “Anchor” action on the right at za = -8.00 with: 

o K = 18 750 kN/m/ml P = 200 kN/ml α = 30° Lu =12 m Ls = 10 m 
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D.4.2.6. Phase 5: Excavation to level -14.00 

This phase is to be defined as a “permanent phase”. Two actions are to be input: 

 “Excavation” action with zh = -14.00 on left; 

 “Hydraulic” action” with zw = -14.00 on left (no gradient). 

 
 

D.4.2.7. Phase 6: Wall creep 

This phase is also defined as a “permanent phase” and aims to simulate the creep of the 
wall. A single action is thus to be defined: 

 “Modification of wall stiffness” action with: 

o z1 = 0.00  z2 = -22.00 EI = 833 333 kNm²/ml W = 25 kN/m/ml 
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D.4.3. Calculation and results 

D.4.3.1. General overview 

For each phase, K-Réa proposes two types of results: 

 SLS results: displacements, SLS loadings and anchor reactions at SLS; 

 ULS results: with or without displacements (if LEM calculation). The ULS loadings are 
expressed in calculation values and in characteristic values (if MISS calculation).  

 
The following figures give a summary of the results obtained at SLS and ULS. 
 
The maximum ULS moment in the wall reaches Md = 1 270 kNm/ml in phase 5. The 
maximum normal force for its part reaches Nd =1209 kN/ml in this same phase. The 
maximum displacement (at SLS) reaches 2.4 cm at -12.80 AOD following wall creep (less 
than 2 cm if creep not taken into account). Displacement at the top remains less than one 
centimetre. 
 
The anchor force reaches 574 kN/ml for the lower anchors layer and 279 kN/ml for the upper 
layer. These values, expressed in ml (linear metres) must then be multiplied by the spacing 
between anchors to obtain the force per anchor element. 
 
The summary of the ULS results also indicates that the verification of the passive earth 
pressure safety check is confirmed for all phases (sufficient embedment depth) and that the 
vertical equilibrium at the base of the wall leads to a downwards resultant. 
 
It should however be noted that the stability of the anchor block (Kranz) is not demonstrated 
for phases 5 and 6, which means that the free length of the anchors is insufficient. 
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D.4.3.2. Passive earth pressure safety check 

Based on the ULS results screen, for each of the phases, 3 buttons give access to detailed 
results of the 3 types of ULS checks. Let us first of all look at the passive earth pressure 
safety check. 
 
For phase 1, the passive earth pressure safety check was checked using the LEM model, the 
main parameters of which are summarised in the results window (see the tutorial on 
“Excavation supported by cantilever wall” for more details on this model). 
 

 
 
For the following phases (2 to 6), the wall is considered to be “anchored” and therefore the 
passive earth pressure safety check is based on the MISS calculation. It consists in checking 
that the mobilisable (or limit) passive earth pressure is greater than the mobilised passive 
earth pressure, with a sufficient safety margin. For example, for phase 6:  

 Calculation value of mobilisable passive earth pressure: Bm.d = 2 138 / 1.40 = 1 527 kN/ml. 

 Calculation value of mobilised passive earth pressure: Bt.d = 1 024 x 1.35 = 1 383 kN/ml < Bm.d. 

 

 
 
Application of a "1.40" factor to the mobilisable passive earth pressure can be explained by 
the fact that phase 6 (just like phase 5) is considered to be "permanent". 
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D.4.4. Vertical equilibrium 

The second "Verif. Eq." button gives access to the vertical balance of forces. The following 
figure presents the result obtained for phase 6. 
 

The balance of vertical forces takes account of integration of the following terms over the 
entire height of the wall: 

 The vertical component of the mobilised earth pressure. It is calculated from the 
horizontal equilibrium of the wall (MISS calculation); 

 The vertical component of the forces in the anchors; 

 Any external forces applying directly to the wall²; 

 The weight of the wall itself. 

 

 
 
Here, for phase 6, the vertical resultant of the forces is evaluated (at ULS) at about 
1 100 kN/ml, which corresponds to a base resistance of 1 100 / 1.0 = 1.1 Mpa, which is 
acceptable given the nature of the supporting soil (Marls with pl > 3 MPa).  
It should be noted that for the case of an anchored wall (phases 2 to 6), the evaluation of the 
vertical component of the earth pressures along the wall is based on a “prorata” approach: 
for a horizontal earth pressure component which is “intermediate” (between limit active earth 
pressure and limit passive earth pressure), the corresponding vertical component is 
calculated prorata the horizontal mobilisation ratio, assuming that the vertical component is 
nil for a nil displacement (reference point). This is detailed and illustrated in part C of the 
manual. It is important to recall that this approach is only valid in the case of initially 
horizontal ground. 
 

D.4.5. Stability of anchor block (Kranz) 

For phases 2 to 6, the presence of anchors triggers performance of an additional check, 
which is a check on the stability of the anchor block. 
 
This check is performed using the "Kranz" model: for each phase, we consider several 
situations as necessary (corresponding to the anchor block associated with each active 
anchor in a given phase). Then, for each situation, the calculation takes account of one or 
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more anchors, depending on whether their bedding zone is partly or entirely outside the 
anchor block in question. 

For example, let us consider the case of phase 5 for which two situations are examined. 

 
 

 Situation 1 corresponding to the anchor block of the upper anchor (figure below - 
left). The reference anchor force considered in this situation is equal to that of anchor 
1 + a part of the force of anchor 2:  

o Anchor 1: 

 The calculation value of its force is T1.d = 279 kN/ml; 

 Effective anchor point (middle of bedding) situated within the anchor 
block => force taken into account 100%; 

o Anchor 2: 

 The calculation value of its force is T2.d = 533 kN/ml; 

 Effective anchor point situated outside the anchor block, but a part of 
the bedding is inside the medium (about 2.24 m) => force taken into 
account prorata of 2.24 m / 5.00 m, i.e. 45%. 

o Result: the calculation value of the reference anchor force for this situation 
is thus Tref.d = (1.00 x T1.d + 0.45 x T2.d) = 517 kN/ml.  
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 Situation 2 corresponds to the anchor block of the lower anchor (figure above - 
right). The anchor points of the two anchors are situated inside the medium. The 
forces of the two anchors are then taken into account in full in the check, or a 
reference anchor force (in calculation value) for this situation of 279 + 533 = 812 
kN/ml. 

 
The stability of the anchor block is confirmed if the reference anchor force Tref.d thus 
calculated is lower than that causing destabilisation of the medium Tdsb.d for all situations 
examined. In the present case, this condition is not confirmed, which reflects the insufficiency 
of the free length initially chosen for the anchors. 
 

D.4.6. Review of free length of anchors 

We will now return to the previous project and increase the free length of the anchors. This 
was initially considered to be L0 = 7 m, which corresponded to a useful length of Lu = L0 + 
Ls/2 = 7 + 10/2 = 12 m. 
 
We propose repeating the calculations with the following values of L0, updating the value of 
the useful length Lu and that of the stiffness K each time, for the two anchors (anchor action 
parameters in phases 2 and 4). 
 

 
Free length 

L0 
Bedding length 

Ls 
Useful 

length Lu 
Kupper anchor 
(kN/m/ml) 

Klower anchor 
(kN/m/ml) 

Initial case (0) 7.0 m 10.0 m 12.0 m 12 500 18 750 

Case 1 8.0 m 10.0 m 13.0 m 11 500 17 310  

Case 2 9.0 m 10.0 m 14.0 m 9 900 14 835  

Case 3 10.0 m 10.0 m 15.0 m 7 900 11 870  

 
By repeating the calculations for each case above and analysing the results of the Kranz 
check, we can see that confirmation of the stability of the anchor block requires a free length 
at least equal to 10 m for the two anchors (case 3). The result obtained in this case (Lu = 15 
m) is presented in the following figure (phase 5). 
 



  D – Tutorial Manual K-Réa v4 

 

 

Copyright  K-Réa v4 – 2016 – June 2016 Edition  89/107 
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 D.5. Tutorial 5: Development of a marine wharf 

 
The example studied is that of a marine wharf consisting of a sheet pile wall anchored to a 
back wall. This is itself anchored by a layer of bedded anchors. 
 
 
 

 
 
 
 
 
This exercise aims to illustrate the following points: 

 Modelling approach for a “sheet pile wall / back wall” system; 

 Modelling of earthworks; 

 ULS checks for a double-wall calculation. 
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D.5.1. Data input 

D.5.1.1. Title and options 

 
After starting K-Réa in “New project” mode, access the Title and options window. Fill out the 
“Title and “Project number”. 
 
In this window, select a “Double wall” project type. The “Distance between the two walls” 
must then be given; this is taken at being equal to 12.00 m for the purpose of this exercise. 
 
Then leave the other parameters at their default values. 
 

 
 
K-Réa then asks you to save the new project: define the appropriate name and directory. 
 
 

D.5.1.2. Definition of soil layers 

The soil in place and interacting with the structure comprises three layers. Enter their general 
characteristics as summarised in the following table.  
 

Layer 
z 

(m) 
γ 

(kN/m
3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kPa) 

dc 
(kN/m²/m) 

δa/φ 
(-) 

δp/φ 
(-) 

Sandy 
loams 

+5.00 20 10 30 0 0 0.66 -0.33 

Clayey 
mud 

-5.00 19 9 25 5 0 0.66 -0.33 

Marly 
substratum  

-9.00 
to -

11.00 
20 10 30 30 0 0.66 -0.33 

 
 
Then use the K-Réa wizards to calculate the parameters for generation of the k0/ka/kp 

coefficients. The reaction coefficient kh is imposed for each layer as shown in the following 
table.  
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Layer 
k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 
kh 

(kN/m
²
/ml) 

Sandy loams 0.500 0.283 3.932 0 0 10 000 

Clayey mud 0.577 0.349 3.062 1.387 4.264 3 000 

Marly 
substratum  

0.500 0.283 3.932 1.237 4.985 100 000 

 
The other parameters are left with their default values. To do this, leave the Modify 
advanced parameters box unticked.  
 
The initial water level is zw = +0.00. 
 
The top of the marly substratum is taken at -11.00 by wall 1 (main wall) and at  
-9.00 by wall 2 (back). 
 
The following figures illustrate the summary produced once the soil parameters have been 
filled out for the two walls.  
 

 
 

It is possible to import into wall 2 the parameters already filled out for wall 1 by going to the 

“Wall 2” tab and clicking . Then modify the level of the top of the Marl to -9.00 for 

wall 2. 
 

 
 
 

Click . 

 
To consult or modify the soil layers subsequently, click the Data Menu then Soil Layers.  
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D.5.1.3. Definition of walls 

After validating the characteristics of the soil layers, those of the walls must now be defined. 
The characteristics to be input are as follows: 
 

 
z0 

(-) 
zbase 

(-) 
Type 

EI 
(kNm

2
/ml) 

W 

(kN/m/ml) 

Wall 1 +5.00 -13.00 AU25 118 104 1.47 

Wall 2 +5.00 -10.00 AU14 60 228 1.04 

 
Note: It is possible to use the “Sheet pile wall” wizard to directly import the EI and W 
parameters of each wall. 
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D.5.2. Definition of phasing 

D.5.2.1. Initial phase 

The initial ground is represented by a 2H/1V bank on either side of wall 1. The ground is 
assumed to be horizontal by wall 2. The following actions must therefore be defined: 

 “Excavation” action on the left, of “Berm” type  

o zh = -5.00 m zt = +0.00 m 

o a = 0.10 m b = 10.00 m 

 

 “Excavation” action on the right, of “Bank” type 

o zh = +0.00 m zt = +5.00 m 

o a = 10.00 m b = 0.10 m 

 
 

 
 

D.5.2.2. Phase 1: Earthworks to level -1.00 

In this phase, we simulate the earthworks between the two sheet pile walls at -1.00 m with 
the creation of a berm to the left of wall 2. The actions to be defined are as follows: 

 

Wall 1 Wall 2 

Excavation action on right to -1.00 m 

Excavation action on left to -1.00 m with 
Berm: 

 zh = -1.00 m     zt = +3.00 m 

 a = 2.00 m       b = 6.00 m 

Hydraulic action on right to -1.00 m Hydraulic action on left at -1.00 m  

 
Caquot overload of 10 kN/m/ml on right at z 
= +5.00 m 
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D.5.2.3. Phase 2: Bedded anchors 

In this phase, we simulate the installation of a layer of anchors bedded behind the back wall. 
The following actions must thus be defined: 
 

Wall 1 Wall 2 

 “Anchor” action on right with: 

 za = +3.00 m 

 K = 10 000 kN/m/ml 

 P = 100 kN/ml 

 α = 30° 
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D.5.2.4. Phase 3: Earthworks to level -1.00 (cont.) 

Elimination of the berm to the left of wall 2. For wall 2, the following must thus be defined: 

 “Excavation” action on left with: 

o zh = -1.00 m 

 

 
 
 
 

D.5.2.5. Phase 4: Backfill and linking anchors 1 

In this phase, we simulate the installation of the first layer of linking anchors followed by 
backfill to +2.00 between the two sheet pile walls. The actions to be defined in this phase 
are: 
 

Wall 1 Wall 2 

Linking anchor action on right with 

 Type: Anchor 

 zaa = zab = -0.75 m 

 K = 10 000 kN/m/ml 

 P = 0 kN/ml 

The same action is automatically copied to 
the left of wall 2.  

Backfill action on right up to level +2.00 with: 

 Layer name: Fill 

 Soil parameters: see below 
 

Backfill action on left up to level +2.00 with: 

 Layer name: Fill 

 Soil parameters: see below 

Hydraulic action on right at +0.00  Hydraulic action on left at +0.00 m 

Boussinesq overload action on right at z = 
+2.00 m with : 

 x = 2.0 m           L = 8.0 m 

 q = 50 kN/m/ml  αe = 1.33 

 

 
 

Note: when defining the backfill action for wall 2, it is possible to retrieve the parameters 
already input for the wall 1 backfill using the import wizard situated under the figure, using 
the backfill action (remember to use the soils database: DB). 
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The backfill characteristics are to be filled out in the window accessible via the 

 button. 

γ 
(kN/m

3
) 

γ' 
(kN/m

3
) 

φ 
(°) 

c 
(kPa) 

dc 
(kN/m²/m) 

δa/φ 
(-) 

δp/φ 
(-) 

20 10 33 0 0 0.66 -0.33 

 

k0 

(-) 
kaγ 

(-) 
kpγ 

(-) 
kac 

(-) 
kpc 

(-) 
kh 

(kN/m
²
/ml) 

0.455 0.249 4.740 0 0 10 000 

The other parameters are to be kept at their default values. To do this, leave the Modify 
advanced parameters box unticked. 
 

D.5.2.6. Phase 5: End of backfill and linking anchors 2 

In this phase, we simulate the installation of the second layer of linking anchors followed by 
backfill up to +5.00 m between the two sheet pile walls. The actions to be defined in this 
phase are: 

Wall 1 Wall 2 

Linking anchor action on right with 

 Type: Anchor 

 zaa = zab = +4.00 m 

 K = 10 000 kN/m/ml 

 P = 0 kN/ml 

The same action is automatically copied on 
the left of wall 2.  

 

Backfill action on right up to level +5.00 with: 

 Layer name: Fill 

 Soil parameters: same as previous 
phase 

Backfill action on left up to level +5.00 avec: 

 Layer name: Fill 

 Soil parameters: same as previous 
phase 
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D.5.2.7. Phase 6: Dredging to level -5.00 

In this phase, we simulate dredging downstream of the main sheet pile wall. This entails 
horizontal earthworks to level -5.00. For wall 1, the following must therefore be defined: 
 

 Excavation action on left to -5.00 m 
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D.5.2.8. Phase 7: Start-up 

In this phase, we apply the overloads representative of operation of the wharf. The following 
actions are to be defined: 

Wall 1 Wall 2 

Caquot overload action of 30 kN/m/ml on 
right at z = +5.00 m 

Modification of Caquot overload action on 
right, new value q = 30 kN/m/ml.  

 Caquot overload action of 30 kN/m/ml  on 
left at z = +5.00 m 

 

D.5.2.9. Phase 8: Tidal range situation  

This phase simulates the transitory phase which follows a tidal range situation (high water at 
+3.00) in which the hydraulic equilibrium has not yet been restored on both sides of the main 
wall. 

Wall 1 Wall 2 

Hydraulic action on right at zw = +3.00 m Hydraulic action on right at zw = +3.00 m 

 Hydraulic action on left at zw = +3.00 m 
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D.5.3. Results 

D.5.3.1. Forces and displacements 

An analysis of the results obtained leads us to make the following comments: 

 The most unfavourable phase is the tidal range phase for which the deflection of the 
main sheet pile wall exceeds 4 cm. The maximum bending moment is about 
287 kNm/ml on wall 1 and 266 kNm/ml on wall 2; 

 The displacement in the service phase remains less than or equal to 3.0 cm; 

 The passive earth pressures ratio is about 2.1 for the service phase (main wall) and 
1.8 for the tidal range situation (main wall also), which is acceptable; 

 The linking anchors work at a maximum of 361 kN/ml (tidal range – lower layer). The 
maximum axial force in the bedded anchors reaches 138 kN/ml in the tidal range 
situation. 
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D.5.3.2. Mooring / Berthing 

We now propose examining the effect of mooring and berthing forces on the behaviour of the 
structure. The phasing already defined is supplemented by three additional phases: 
 

 Phase 9: restoration of hydraulic equilibrium with water level at +0.00 everywhere. 
 

 
 

 Phase 10: docking situation represented by application of a linear force of intensity 
equal to -200 kN/ml directly on wall 1 at level +4.00 and angled at α = -25° from the 
horizontal; 
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 Phase 11: berthing situation represented by application of a linear force of intensity 
equal to +346 kN/ml directly on wall 1 at level +3.00 and angled at α = +30° from the 
horizontal. In this phase the linear force defined in the previous phase must be 
deactivated. 
 

 
 

 
Restart the calculation and access the results obtained. The next figure compares the results 
of phase 9 corresponding to restoration of hydraulic equilibrium, with those of phases 8 (tidal 
range) and 7 (start-up). The “tidal range” situation causes an additional displacement of 
about 2 cm with respect to the service situation. The return to hydraulic equilibrium is unable 
to cancel out this additional displacement: the deformation of the wall after restoration of the 
water level at +0.00 m remains close to that which was obtained in the tidal range situation, 
which means an “irreversible” behaviour of the structure linked to plastification of the soil 
under the effect of the additional loadings in the tidal range situation. The same behaviour is 
observed for the back wall. 
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The results of the mooring and berthing phases are summarised in the following table, by 
comparison with phase 9. 
 

 
Deflection 

(mm) 
Mmax.1 

(kNm/ml) 
Mmax.2 

(kNm/ml) 

Tupper anchor  
(kN/ml) 

Tlower anchor 

(kN/ml) 
Tbedding 

(kN/ml) 

Phase 09 42 282 262 54 350 138 

Phase 10 49 265 260 191 363 157 

Phase 11 41 277 259 100 353 148 

 
 

D.5.3.3. ULS checks 

The previous results can be supplemented by those concerning the ultimate limit states 
calculation. For this, go to the “Title and Options” tab and tick the “Perform the ULS checks” 
box. The approach selected by default is that of the NF P 94 282 wall model (approach 2/2*). 
 

 
 

 
The fact of activating the ULS checks in particular allows: 

 Determination of the ULS loadings used to demonstrate the structural strength of the 
retaining structure elements (sheet piles, anchors, etc.); 

 Justification of the distance between the two walls with regard to the stability of the 
anchor block (Kranz model); 

 Verification of the pertinence of the active/passive earth pressure angles and 
evaluation, as applicable, of the force to be taken into account to check the punching 
stability of the walls. 
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Before restarting the calculation, the phasing must be supplemented by the following 
elements: 

 Phase 02 / Wall 2 / “Anchor” action – input the following information: 

o Useful length of anchor Lu = 8.5 m 

o Bedded length of anchor Ls = 7.0 m. 

 

 
 

 Phases 07 (start-up) and 09 (return to hydraulic equilibrium) to be declared as 
“permanent phase”. The other phases are declared by default to be “transitory 
phases”. 
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 Phase 01 / Wall 2 / Right / “Caquot overload” - Nature = Variable.  
 

 
 

 

 Phase 04 / Wall 1 / Right  / “Boussinesq overload” - Nature = Variable.  

 Phase 07 / Wall 1 / Right  / “Caquot overload 1” - Nature = Variable.  

 Phase 07 / Wall 2 / Right  / “Caquot overload 1” - Nature = Variable.  

 Phase 07 / Wall 2 / Left  / “Caquot overload 2” - Nature = Variable.  

 Phase 10 / Wall 1   / “Linear force 1” 

 Phase 11 / Wall 1   / “Linear force 2”. 

 
Restart the calculations and directly access the EC7 checkings. 
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 Passive earth pressure safety check: the stability of the wall is demonstrated with 
respect to the passive earth pressure safety check for all the phases and for the two 
walls, except for the return to hydraulic equilibrium phase considered to be 
permanent (irreversible plastic deformation developed during the tidal range 
situation), in which the embedment depth of the main wall (wall 1) does not offer 
sufficient margin with respect to the passive earth pressure safety check rupture 
mechanism. Elongation of wall 1 is therefore necessary. 

 

  
 

 Vertical equilibrium: the verification of the vertical forces balance leads to a 
downwards resultant for all the phases and for both walls. The maximum vertical 
force to be taken up (at ULS) at the base of the wall is: 

o Rv.d = 219 kN/ml for wall 1 – reached in phase 7 (start-up); 

o Rv.d = 171 kN/ml for wall 2 – reached in phase 3 (elimination of berm). 

 
 

 Kranz: the verification of the stability of the anchor block aims to validate the useful 
lengths of the bedded anchors and the linking anchors. The result of the analysis 
validates the useful length chosen for the bedded anchor of wall 2. The stability of the 
anchor block is not however confirmed for wall 1 in phases 8 (tidal range) and 10 
(mooring). This therefore requires a revision of the retaining structure design by 
increasing the distance between the two walls (and thus the length of the linking 
anchors). 
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D.5.3.4. Revision of structure design  

The purpose of this paragraph is to present corrective actions required by the structure’s lack 
of stability with respect to the following mechanisms: 

 Rotational instability of wall 1 by passive earth pressure safety check; 

 Instability of the anchor block associated with the sheet pile wall / back wall system. 

For this, we propose the following: 

 Increase in the embedment depth of the main wall by 25 cm: Open the “Retaining 
wall” menu, select “Wall 1” and modify the level of the base to -13.25 instead of -
13.00; 

 

 Increase the distance between the two walls by 2 m: open the “Title and Options” 
menu and change distance “d” to 14 m instead of 12 m. 

 

Restart the calculation. The result obtained shows that the proposed adjustment this time 
enables all the ULS verifications to be validated. 


